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D3 3 dl 3UB] Home Menu Bl #ASS ool 3l U390 | T34 s U A 3iivgred 2w o/ 2 i =l
3T Text BIL Formatting B3 DB &... R Text D! Bold TIoll. Italic BIo, Underline BIoIL,
Justify eIl Text T Size I T3] Al BICT BIGIL, Text DI clRioiI FUH Bl TaIe oI Tl Iclie
disil DI 3 el & gRI P S 3.

1 pri

| Pt 1 e Frme-
A | e e L Lo sasern AZBBC AsmBe AsERC: semnns AAD | A FRAEE
WECHENE = B 1 TN e Palamy fiadugl ' Hiasegl Heiigd  pecnad e | Oues L

S.N Options Coverage
1 Clipboard Paste, Cur, Copy, Fomar Painter
Bold. Iralic. Underline, Strikethrough, Subcript, Superscript.
2 Font Font, Tont size, Glow font, Shrink font, Text Effect, Text
highlight color,Change case, Font color, Clear formatting
Align text left, Center, Align text right. Justifv, Bullets,
5 Paragraph Numbering, }Iulﬁlnli'rel list, Linie & Paragraph s.pacing,
Decrease & Increase indent, Shading, Border Options, Sort,
Show & Hide Paragraph marks
= Styvle Change Style; Style set, Color, Font & Change Font style
3 Editing Find. Replace, Select

e ——
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( Clipboard )

= Cur; 30! Aca A 304 [t aft Text &1 Object B Cut Tl 3H 7206 A &¢I AP & 31l B
FeIlol U3 ciloll T 3 33 F2il6] U2 5IIch3 Paste dlcl 3iT9l6 U3 [dei B3

= Copyv: 33! Acc H U 534 il Text AT Object B Copy Alall FH Duplicate I Hdbed 2 i
{35791 Fer1et U3 34 33901 dIad & 34 Fellal U3 SIIh3 Paste dIci AIT9l6l O3 ae @2

7. Paste: Paste @I S¥clellc dl Cut <[ Copy & dIc 2l ool 71 Awal 2 S e 3del 31del U3 A
2l 9l 33 fE6l Cut AT Copy @ Paste 61 ¥l olal @I Hdbel

=. Format Painter; 2] dgd 2l HIc DI Feature 2 FElich 3D Ace A 3T oAt ot Text & 3an
o Text Eﬁ[é’@ Formatting @3 Hod 2 Helid 3E1E 3ot [E63ft Text I Bold, Italic. Underline
fooen 2 3fis 304 @iac 2 320 O ST 36 Text #l Automatic Formatting 31 3IRI al BA 31 309 HEGAH
UZcl 33 Text Bl Select @2 [3135 A1 3T 33 Text ﬁmmgﬂqﬁ $1191 TBI Select Il
31 oIdl 2 AT UF Word I 8l Seclect B3 IHa 2) 3P 9IS Format Painter U3 o &3 3
537 33 Text U7 3 33 Raaorl 559! U Change 36l &01...30U 240! 5 at ot Text
UEcl & 311 21 e 5198 SiAr 31d e aEd &

2 Bold: 30l AGE 3 31U G531 81l Text @I Bold 3181 [t ot Text 3 olIST Darkness o Hbd 2
3D [c10 HGA U2l AIUDI Text DI Select TDIall Z1911 IHD dIG Bold dAlct 3iiglel U2 et 3
= Iralic: 306! Ace 3 ot it Text B Italic Hﬁwmmmgﬁ Example (1)

= Underline; 321 #Aice A A [ 3it 8l Text DI Underline 3 APd & 72 Underline

= Strikethrough: $2h1 AGe A 30T [l 8l Texr o1 didl-dla TIe F®d 2 A2 Example )

= Subcript: mﬁmmzﬁﬁ%mﬁﬁ%@@m 2 aeilics 4 [l ol Text &
foraret atet 3 fop 3t 16T Text I Type BITAI 2 AA: CH.N, H,0, NO, IS

gllc: 3 3iiorel U2 [ @3 &t & 3iivorel Enable 21 S9N 3017 Text & foract sirer 21 Pramen
<le] 2l FIEPIL...

= Supercript: Subscript 5t &t Tex: & foraal sie1 3 forzaen 2 Al Superscript 534 8 Tex: 3131
1191 31 [CT3aedl 8 31 (a+b)’ =a+b™+2ab, (a+bh)’ = a’+b*+3ab(ath) Sl

7. Font; SHP 3662 Ps HlJ Font Style &0 910 2 572001 U=ISI 3T Font Style @I Change @6l B
= Fomt Size: $2b] AGE A U 3iUal Font Size I 3ibie FU A Type Db BICI <l G31 B Al

e

2.
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= Grow Font; [cbHl #f Text @1 Select T3al & gl 33 3iivglel U3 f&ces B3 1 3UHI Fonr &if-
=. Shrink Font: 2520 &ff Text B Select Bal B aIc 27 3iirorer Uz et ©3d 21 3UDT Fonr #ff3-
. Text Effect: 331 dAce A ol #fl Text A g RE Effect SI@ FAPA 2

= Text Highlight Color: 33 5113l 31T fa53it ot Text I Select T35 33 Hichlight T3 A 2
= Font Color: 33<b Sl 31U b2t Text B Color I 31Ul 6113 95cl AP 2.
= Change Case: i‘mgﬂﬁama @I Feature 2 Qellich 3] AGS 2 30T Direct KoL 8l Sentence

@I Manacea B3 HD 2 5120
M=t Page Layout References KMailings Review
(i) 3FIZ APl P sentence small vk Aparaita (A=) | 3= - 3= -5
!Etter ﬁ- g iﬁj m alaﬁ gﬁ ﬁ‘I :H].I[ - f Forpaal Pairder | B £ O - ke x x| by Sectence mie,
= Clip bard . : fowercase
Sentence Automatic CAPITAIL Letter - | | UPFPERCASE
él- [EiilE] Ff[ HIO UPERCASE o1 ] i 3 Capallze Caeh Ward
JOGGLE £ASE
S¥ci9AIc] ol S2cldlc] 3 ADd & :

(1) 391 3MUPI W Sentence CAPITAL Letter 3 2 3017 30U F12a 2 I35 9l AL Sentence Automatic
small letter 3 21 31T 1l DA A 30T lowercase I 3FcIHAICI B3I bl &

(iii) 31913 30U T2 2 o 53t o Sentence o1 316 uzet 3Bz Capital 2l 317 ardh! A4 small letter
2l dl U A 30U Sentence case DI 3Fciellcl DI ADd &

(iv) 4P [Aadled PR 3T T2 2l 86 AT Sentence B TSI 31612 BleT 2l 317 G15b! DI 3461 31
2 Al W3 # 30T tOOGLE cASE I $I0HIc B3 APl &

(v) aies 3 araa 2 195 33 318 Sentence 35 F3lt Word 961 USET 31813 Capital 31 3112 a1eb! &1 Small
Letter 3l 71l B2 & 30T Capitalize Each Word @I 3Zcifld @2 J9d &
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= Clear Formatting: 3 8ii @Il BHIA BI Feature 2 Tellich 3D Hi<d 4l fdven o1 Heban 5
ZHcAl ! PIol 3 DIB] T olo] SIAT 2 el P12 3Tl TS off Text B Type foem iz 334
s HlJ Effect DI Apply D2 [&ar 367 30U 3 Effect Bl cToll Aad & dl B & 39 gRi-akt J
Undo dcel @l 3¥AFAICL I8l | #9132 3H HITlel U3 fdretes I &1 b 2l &3 # A Effect Clear 81
SIEPIL.. 51 3T Apply [doer =0

Paragraph

7= Align Text Left: 36 300 3 3iivole] U3 fdcies 39 DIS 8l Text Dl eRdeI dl Lt A 9Ix ST
303 Right fo5 3013 FFIL..

=. Align Text Right: 33 3iIvoldl U3 fderes ©39 519 34 DIs 8l Texr Pl ool Al Al Right A 9=
2l Left fdb 3112 M.

= Center; 33 HITYIE Bl Select DIb 74 30T DI #l Tex: 1 o129 7l 91 3195 Page T Center A
ferearen 9= gton 303 Lefi. Right Sloll A0 G&al SRR

= Justify: SH 39 B Select BIb bl 8t Text ! fcrzaal wo 3511 ol femam@e 2idt 2 at
Vertically Left 303 Vertically Right b fo® vepca HaIel il 2 5l o5 Saet @ Dbl =1 oisldl
g|

On the Insert tab, the gallenes
include 1tems that are designed

to coordinate with the overall

(=] b 5
look of vour document. You
glic; 32 Pl ! 304 o2l ol Text B! foraet & can use these galleries to mnsert
acdtmrTasas tables. headers, footers, lists,

cover pages, and other docu-
ment building blocks. When

you create pictures, charts, or
diagrams, they also coordinate
with vour current document

look.
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=

= Bullets: 3 30T 3Ta1 Paragraph # 1220328 T Bullets T8I I 2 5120

/

® Example (1)
| T | aaBbenc

® Fxample (2)

® Example (3)

T Falled | itwaiy

-0

(2 )

lle: 2% AT Buller 30UD]

“Define New Bullet” Tlcl 3IT9lel A
IE; !

(I-' - Dlefine e Biallet.

+

<= | change List Leval

= Numbering: 2op AN 3ma ool oft Paragraph #H
Numbering & AP 2 | 3AP o8 37 w2el & 331 3iivgret Bl
Select @2 HPc] & oI Al Paragraph €131 alol & dIq aif Fsit
DI Select DID A TG BT SIAHAIC] B3I ADA &

II'F
1. Example(1) (9 )
2. Example (2) il 3% Afae
3. Example (3) Numbering Opton
4. Example (4) IE! “Define New Sy T———
5. Ekﬂﬂ':lplf' | :_".] xurﬂhff Fﬂmlﬂf'. qﬁ- I:_:-ri'n: Feys Humgsr Format.
.q: % g ] FA
arg facier
(2 )

BlT: SLAT List 3T oi91 JHAT List 3IUh Alc! A3 2190 Aeid A, B, C, D AT 1, 2, 3, 4 Scaiic
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= Muldlevel List: 3 S “Multi Level” Numbering List d<13 {6 Sar 2 | 2361 U=l

FEIICIAR [P Foild o Multiple Choice TIEtel B53d 9 feen AT 3

1) Example List 1
a) Example 1 i 2 S P Astb
b) Example 2 - |
¢} Example 3

d) Example 4

1. Example List 2

1.1. Example 1

1.2. Example 2 | | et 1
= 5 - 1.0
1.3, Example 3 . l;qu.a:;;

1.4. Example 4
Chaptar & Has
1.5. Example 3 s | st
Heading § —

1.6. Example List 3

Change L Lavel

1 6 1 EEEIHP].E E Delire Pieiar Buftileve st
T i Diefing Feow List Sty

1.6.2. Example 2

1.6.3. Example 3

164 Example 4

1.6.5. Example 3

[

Example List 4
2.1. Example 1
2.2, Example 2
2.3. Example 3

2.4, Example 4

379 30US] HeAe A 31 511 S191 [ SHep1 Ueiiel el 2ldl 21817

oGL: I List 2 (1413 D17

HaH Ugcl 3IUDl Kﬁﬁaﬁﬁgﬁf{@ﬂi @I Choose @Joll 2191 3HP IS Text ol BI
3iftgrel 3M=PIL.. 514 309 Text 129 Gl I 33 491G Enter Gall 33 416 d2d Tab dcdl A B3
ﬁ??ﬂ&ﬁﬁiﬁ?ﬂﬁiﬁ]ﬂm&ter 313 Text [2738 37195 @16 53 Enter 33 Tex it 2t a3
31 [ 3! e 2 |

Silc: SiAT List 3T Choose T5391 AAT 21 List 3ol HAlHol <13 2191,
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= Line & Parderaph Spacing: 3P Sl 30T Hall arden Mo
U3eIG] &b &l cTEfoiel FUM @I 3ol eI Hel Il 96l AP &

P NE

T Moimal

Fuf3er 3 Featdn 3z ot siftiss o &
fé1re 3T “Line Spacing Options” U2 fdere o3

Th

Ling Sparing Options..

Ada apace BeTore Paragraph

Add Space After Parzgraph

% Decrease Indent: SHE] 30T Indent DI Decrease BIal b (o1 [oodl HAldl 2
5. Increase Indent: ST S3AICT Indent T Increase Jol O [0l [ AT 2

Fizrt Line Indent

Hanging Indent

Left Indent

S —————
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= Sort Text: S Siteel 30U BBl oft Text, Number &1 5 e
Dat= 324l 3iC9IET Bl Sort 3olld Ascending Order &I || e
= il L] ik e et wrwion
Descending Order & H51 Hbdl & | SHD fome 3y oot oft ||
Text. Number T Date I Select 535 33 M9 T <51 i:::; I
. M Times by |
DI ADAS = o row ] Bt |'
My lsthag r1
CoHesderow & Nonesder oy
= e ||

= Shading: 3315 13T 30 530 ot Paragraph # Shading € Fd 2 | 2536 e med gt ama
fooatt oft Paracraph U3 #I3H @I Cursor & TR 3P GG Shading dlcl 3wyE A @3 P8 TP
i3 I TElol DJ | 3 30U 290! [0 Text @ Backeround 3 3[od @il (2ol oiell 21911...

7= Border Option: 3o10b itver g faeaft oft Texe & Left. Right. Top, Bottom —
w = L |
<l 131 AP diS3 ¢ioll IDd 8 | IAD o8 3T FG3 3 Text B Select et Ao

1 Hormad

@2 53 Muss! di=3 oolel 2 3HD 9IS Border dlc] 3006 8 F0T T || 21 gotion soreer
- T TopSorder
31Us] 3f6IAT I BJ... E1 yertmoraer

1 Hignt Borcer
=5 Ho Border
Al Borders
Cringmie Boroers

2. Show & Hide Paragrapgh Marks: fcreies I 30U 3 3iivglel & FHEI & Insids Barders
el TN 3P & [ JIUPT Paragraph Pl forrae Tl A g g E 3z |7 ettt
PR R vard .

Lraw |25k

M View Gridenes
Dardare and SEading.,

= Style: 3HII [&ci Baal Al 3Ua! Paragraph W1 Font Style Change 2l IO | 33451 U9l 54Ul

— ikrrge

| aseicone | aEheene AgRBC AaBbCc AsBBC sssecen AHHB ﬁ&
themeel | MnSeedng  lencingl  Hending Wafingd  HesEngd Ele ran
1 L 13

Sldxa
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7= Change Style: 231 3loc: &t adt aiivera 2 s A9 309 Tet &
Style 31 GGcIId ol Il & A Text DI Doid Ioddll, Font Style TGclall,
Paragraph Spacing 31 dGcild cllell 3cdlic... | /88 Find -

3as Replace

nge
i Selet v

Shyle 5ai »
Colors ]
Fants ¥
Faragraph Spaong #

Set as Default

= Editing: ¥ q 3iIvolel 2 3o Si¥e 30Ul @ 3 & w2t
ABAI s

(i) 3913 3MUD! DI & Particular Word B FIsel 2 Al 3T Find dlel 2 Find -
3iftoret 3 331 Word @61 FIA ABd & 5. Replace

(ii) 3013 30T [ Particular Word 35 31912 U3 I3 3169 Word Replace b Sefect~
5Tl Al & dl U2 A 31T Replace dlcl 3T9lel &1 UHIo] 3 Add Editing

(iif) 3L Select alel 3iiverel P aly # [T elie! b 5iwad oidl 2 30U Tc et Abdl 2

S —————
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(L'-si ng Insert Eielut)

SEHBEO2 M @ B
Id‘.' Babi— ':,I. ||-...rh'.-.u+ Chail & nd Hapedhai baadhel i

SN

Under Menu Option Coverage Topic
Cover Page, Blank Page & Page
1 Pages
= Break
2 Tables
Table
i Illustrations Picture, Clip Art, Shapes, Chart,
i Screenshot
4 Links Hyperlink, Bookmarks, Cross-
reference

Header & Footer

L¥ 1]

Header, Footer, Page Number

Text Box. Quick Parts,
6 Text WordArt Drop Cap, Signamire
Line, Date & Time, Object

] Symbols Equation & Symbol
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= Cover Page: #AISRIAIIC O3 7 s H1J Default Cover Page —
6Tl Follell I I3c 2 30T B! IFIolc dad b s 1 [
3 AP & T A MUP! TB Text I forzgen gon s = =
IMUBI Cover Page Ready............

=. Blank Page: 33 olld A 2l 30! AHI 3 31 oK1 2o 6
$2®] 991 DE a7 5l &1 3] Ace 2 34 AlShIAlle ds 3
U9 Blank Page ol APl &...

=. Page Break: 23 ollf A mmwgmg | a0 g3ebl #Hce A 33t Particular Page Bl
Break ¥lIoil dls APl &

Blle: #AT3H DI Cursor (31 Fellel U3 Bl mﬁﬁﬁﬁﬁFageﬁBrﬂkm ﬁ?@ﬂﬁ?’ageﬁ
331 ¢l &olLL..

= Tables: 320 G 3T Tables Bl Create TLADA S | AA A [ | moeroost | Reterenes

oolcl b & I3 gl 3iivgiel 3 304 ¥ 33 3iivglel A FIP7 ardl- | [ B8 P
a3t 3 UGt 3GIAR Table P! Insert I AP 3...

= ZP Hocd AT IS A Table Draw ®Iot P [CIW “Draw Table”
I 3iivgle] feer o 2

= 304 {3 Row 33 Column Tel Tables Draw ol Ia3d 2
TP 18 “Insert Table" I 3iicom] fGan sEn

= 3P 3cidl 3HA Quick Table, Excel Spreadsheet, Convert Text to
Table b1 ot 3iiverel f&ar o 2 3 [ Direct 31T I3 Insert &3
ADBAE

Excel Spreadihest
U Quoick Tabies

——————
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= Picture: 3 3iItglel U3 {dcies ©335 3T 31U6l BT A Picture

] ok

B! Insert I ABcl & e

——

= Clip Art: 3 3iitglel U3 i B &l 3UD Aol e 33 || | =trmii=

METIdMvE s con A e bRk Aftarm Iz S owRm
Y 3 Image ] ARDIATE T2 H Insert BIol A2d 2 3H Image
! [o17a@57 Search ®3 2 3A HTHI MS Word A cl=L

B Micrmeh

@ 1 1

gllc: 3l Image ARDIAIGE a2 & Offline Zl0I 92! JFPEN 36Tl
3T Internet On GBI 32 DI D] DI HADd a...

=. Shapes: SAP o IITD] De HlJ Shapes [0 FE6! 51a5! 300 AEHETE a3 # Draw &3

d S Ol k=21 | [ 1 L T
> 4 0@ 4y 98 ® &
& ¢  O0v el 0> % &
~ & @ DrpeE Lo 0 < {8 -
= ~ 3 O\ A D= @5 =<
9 o~ 0 6Ib #0 B @8 O 2
0% + 0 dLO®~ ©@¢ ® e o0 § ¢
0~ & J QOD- T¢ gl O®@ 40 ° g
Ov o, 0gA0C~§>€ F4 U5Q59D QW 4
7¢ 2302906-365¢in§0U0E+E 00 §
/ifEf." DgD@@ﬁgGﬁ%Eﬂ DDDﬁﬁE‘ £qul
fles/ e]aeaCsfwnddeJods3gG S0 LR

7= SmartArt: & #i U Shape 1 EldI 2 PR A S
oIIST Stmart 33 Category Wise 2ldll 8 =il b || _.: . -
Insert BIP Yol PIol B GIG G20l H PIBL || = =

ZIEAIA CI9ICHI & SACE $A SmartAnt BEA 3 || & 2
alle: il Categﬂryﬁﬁﬁ Shape 3ITUEDI B ctel || =
AW [Gcis T3P Inserr DI 33 3H MWl
3[GJAI3 Edit @3 | Al Text AT Image 3HH Add |
D26l dI&d 8 3H Add PI... =
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= Chart: $3PI 511 ollH 2 4l 3451 D
2 | 39 3HP A MEIE P IO
dRIlZ I3 AP 2 39 A IS HUI
forsts waan 2 o5 3nus! 5w aee &t

g Ul 30U [l v I W e
B IAPS dc AUel HAHAA Excel
Worksheet Fcl Srien {376 30T 36t
316113 I P Manage 3 AP &

=. Screenshor: [513 @38 2 3T 3ITcl AlGISc H Screenshot ol 2 oI 341 ISR A 54 304
HISOIAITC © Hocd 52 3itoE U7 [Ace ©Jel Al addlol Had & oil U HiHol blal U3
feaas ¢ 321 2 Al Automatic FEbIclglic 2163 SHHA Insert 21 FRPIL..

= Hyperhnk: 3o FI 3T B

316%1 G151 DI Short Link B3I BBAZ [|[ e temiem

selid fopall 53 wEa S sifEL i e B 3 =
x “_ﬂ- - Eﬂjﬂ EﬁE r E1 Word 2043 fra )

foics & U & create BID 339 Insent

2 ADd 2.4 U et gHy

daARe @1 99 Usl o1 i © J@d 2

3t STaegdic ar 3iif=<l, f[AfS=l ©I Open D6l 201 Al U] Cirl &5 TS 3A Link U2 fci® el
BMe1L..cd 3 i Iget SiEen

P Hyperlink foral &= =11 321 2 [5735%p 3t5c2 4l fiiep [&=n o 2 o e e & 2 Jga
Website Computer Notes YouTube

U daAee o oo #ft da UF o1 fofes BH Creae ©2

3t12: Option (2) <IIGl Address & 3918 U2 Link STl 3i12 Option (1) el Text to display # Link I
Name STci (3133 316 Link Show oigt 2lon B1E Display Name Show ZI9IL..

sile: 3ifvgret (3) 303 (4) 3 AL 30U 37Uct DRI A BIZd B Attach I HPd 2
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= Bookmarks: 3P oA # 2 SHPDI DI Ul g3l [ammark

2 | & 399 Document # Mark 3121 [RIeg cEIERI | Bookmr rame:
[ 3uet 521 STTHcH & [Pl Reading G 3| |
ﬁmﬁmg&ﬁmmaﬁnﬁaﬂaﬁfi
3uen] A1 [SarRen 56 3ol i an ©al ab |

U] 4L |

aite: MUt A #b AUB! e A eolet 2L B | o san
3[051 3ol Bal d® USl 2 dlfeb el 30U 3HD ) Lozaan
= e oyEn | [T e beckrmarks

[

33 FaH USel 3T AZH B Cursor T2I U3 A AT S12T I ol 37 Siagdic &t uas forn &,
3P dIc PAD 3 308, 3AD a1 Name & A2 3H Add B3I S... Next 12 519 U PP dlel
3iivgret # SRRl Al 92T U3 <1 o1# Show DI 51l 30Uel 318t STei oI

5. Cross- reference: 33 31T9TG 90T UEIST Hcilol “Reference Menu™ # 2l fAram A udal

= Header: 331 3ivoTel 35 SALI°I 30T 3106l U3 3 Header Create 53 Hbdl & | S0 (01T 30T 5ac] 3H
3iicglel U3 fdei®s 3 307 316l 3633 U Header I I B3...307 U5 &P Header # Sl Text
(RIS o e 1 FoTo s 1 (i RO

. Footer: @ #l Header J1HI &l I DIl & & | Sl Header I 32 U3 & FAaA 3091 HEI 8ldl &
&l Footer 51 FAcicid U b Ha ol ol 2ldl ...

=. Page Number: SHA 301 30ol U A Page Number Show T2l bl =
2 | ¥R ¥ AP HU2 ol Pl 2 [ 31U [5F e W3 Page E A=] ;I
Number Show Ialel dI&d 2... 300 REI A 53 AP 2 e RS Tl

umberT | BoxT
Tep of Pegs

Bottam of Page

alic: 34 513 3iitgrel @1 Choose @3 32 Fellal 2 Page Number Show

Pzgz Margins

Cumrent Pasitian

Eormat Fage Humbers..,

=% Bemove Fage Humbers
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= Text Box: $H3A 30U Text Box @I Draw @3 A & mm;ﬁﬁﬁmmg
= Quick Parts: [&52ft aff Text B! Quickly Open T30l & fcm
3 3iigrel I 3¥csue fooan Sl &

(1) AutoText: GIF3HA 31 319 31U TH 3iiv9lel U3 drei el al

= 'd 4= [ Sigoature Line ~
""'| — ) Date & Time

Dulek 'WordSel: Dy

316 Blank fozen 3y 5 sudt AT B S Tt aa 35 [ pora e
3ece dl A3 Text [&3T0l cro1e! [5Ia0! IUS AvtoText B FUA || s pocument mapeny
3 CI9II 21911 = Field.

|3 Bulidirsy Biccks Drgamizet...
e

SICIFAIC DA P37
g1 Ugc] I Silel I F3PI FxadIc ARa7 Bl Zlar 27 ol & 309! adl ¢ Pl 59 SHAcHel Bl
@15 8l Word &I Sentence Tl FP2d 9I3-413 2l 2 dl U A Zdciel 34 9R3-91 foreaa € #em 33
sifcgrel & i3 3y Bid v o 3 4@t 2 o o 2 Sl oolel @ Dusit B B U3
3Tst O3t S, T3 9T Udl 3carc wisil Bl 31T U a1 3 @2 APd 2 312 U & # 3
CRU DI ADA S |

forET: a3 UZcl 30U 33 Word I Sentence 1 2130 ©I ol (3 AU BE Ao A den diga 2

Lﬁ Signature Ling =

331P 916 “Save Selection to Quick part Gallery” U2 [9ci® D ‘q

DIP TP Blel Il olld ¢ ¢ dlid 33 VI A olled Pl 13} Date & Time
CI3U P3P SEIIAC 3H TS I ASH Pl 7l U [dap || *3 Object -
3 oI I AP

Deoument Praperty

51 a2 & 309 ofidee goi=n 2190 3H a2 ©f eET e
@301 b dI¢ 3T hials & F3 Button UH @I..... Sufiding Blacks Organizet...

aave Selection to Quick Part Galleny,.,

(ii) Document Properties: 3381 EE) U dom G am 2 2 4 A T | JbusY
_ . |-. '|.._|. -:'.I" Fats blm:-i.‘ihn:

{513rep1 et u=ller 34 3146t Siaedic # @3 APA 2... T R -

3121 Author, Subject, Company, Status Etc........ " e 1

catigury

Cammeiy

ik
CoEnaTE FRAT
Lrcfely doh LT
Do e i
Compnin Flniie

L

ealyr
Pl Fuis

Saed

Batimat

(=]
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= WordArt: IHA TP B2 32 B Text Effect i FE0! 530z 3ma
arst-ast 3 oo 3% 53 Fd & | A BB Amazing Effect BT 3

= Drop Cap: 3 BBl Amaring Jiivgrel 2 orlfs 33 A 3nu [ ot Sentence B Al=T
Attractive Jell Hbd & (313 Gal A PIbl 9leIc? clelell... 3l 3H A Bl JiaHs Ian] A
o= 2o

sile: < 3iicgrel fepat #it Sentence o UScd 31812 W Fgd g1 (1Al 2 | 379 3 31U HUZ Depend 2
fe5 31 fepral erdail @ i 31 3iivglel Bl 33AHd DI IR 2...

Example;-

= | & signature Line =
55, Date & Time

n the Insert tab, the galleries include items that are designed to co- ‘o Object
ordinate with the overall look of vour document. You can use these aroe
galleries to insert tables, headers, footers, lists, cover pages, and
other document building blocks. When vou create pictures, charts, or dia- Eireppred
grams, they also coordinate with your current document look. e el
A= prop Cap Options..

[

= Signature Line: 5i-50 3ifcolol 393 Y@l 51 381 3 A T4 [ o LR
3iitgret Fill @39 Ok Y., 3@ T Sl oo 3Much U & Al || sseesmosor for cvanple, sy

JTd Details Insert 21 IR 3l 3o 304 Fill [S5em en | Skmsiod s e (s efiarcte, Maot

S pgertod sgner A g maid adneas:

Ittt 1ol sghee:

.B:ru:e wring U doourent, venfy st the cortenl yoo
r\e SO IS EnTEsE,

1 mBow B cigrer to azd consentn in the Sgn detag
& Shawesign date m signemre lire

(o [ conn
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2 Date & Time: 338 30UPB] dIZ-d38 & Format 3 Date
& Time Insert TIol I 3ivolel B FEFPD MUET 3 e

ApE, 13 =oAL
=

Format 381 Aoldl 2 33 Formar U2 [aci® ®3 307 Inserr | noi

ke e T

= Object: TH 30916 &b Aac A [l A6 Programs =
313 BICIYNT, UFcl, I3 IS A PIA BIB AIA || oo [ammmimnse

[ H Al PV

23091 Insert 53 ADA 2 91 USct A DI Text File dail e —

ﬂ'{—_ha_ﬁ . Th cl-r-k'lu.'.':T.'j-Im__n-||-m
& 2 2l it 30T 33 Inser: DI FDAL... e
oot Diod 370001 ¥orkshest
B S

Iierlaa s Aot Pl e nge |
“E TR Wil O

= Equation: 3051 Udle] FAUIGII3 Equation Holld A e Far 2 o<ifos 38 oo A A
3ifraret 2 3127951 W=IsT Equation 35 31919 2lell ARERI 2.

T &= AR IR EEEER

et 3 1 R 1 2 N

o

FIEEEE. 2 efup [ 5 {0 we g im A [
| :-E-i_ Il‘-l-'--: ||-.:m- '\.r|111'| leux ] Dpﬁl-:.:l' hn:‘ln Fenaen drrk |-:I:_-.n dmruor vmiry

aile: 309 adt-art 3 J8ft Equation ! T5Id B 6lAR [Ga® BIb c- APbd &
= Symbol: $HD A5 FUP] dIg-t32 D Symbol [Fic 161 f50e1 U=le] 304 36l Aa9ddml

e ST IR i i ILAE 9t A SR E o L L R0 Fi
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(L’sing Page Layout Menu )

Frtwrmts Veikrge L F i L

TEN | 5 hi B[] e = T Laden
_-l |25 I—‘I |--| 159 e v = 1 a l‘] - T

[T T e | WEnEas Pl i
[ b . o Fimtoien - Cake = Hanieyy | B RRgALT

SN Under Menu Option Coverage Topic

1 Themes Themes, Colors, Foms & Effects

Margin, Orientation, Size, Column, Break, Line Numbers & Hy-

2 Page Semp shexgitior
_ 3 Page Backeround Watermark, Page Color & Page Border
4 Paragraph Indent & Spacing
5 Kiisias Position, Wrap Text, Bring Forward & More, Send Backward &

More, Selection Pane, Align, Group & Rotate

S —————
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= Themes: 3GE1V] & CII HAS!: THDI SrclAlc] DIol b [c18 3T Insert Tab H DI 8l B Cover
Page b1 Select s | 33D GIc Page Layout P Themes TlcT 3o # 0 3 adt-ardt & Fft
3ifcora 13 oo @2 317 & 95 33! Apply T30l & 491G 33 Cover Page 3 o<l Ulddciol 3l & |
Themes @lcl 3iIt9lal # U] B3 12 3o f[a 361 Bzl s7aed 30U B2 APd & A
Themes, Colors, Fonts, Effects,

=. Margin: 3705 5% 30T TSl Page I Margin Set B2 APl &

= Orientation: $3<b F13e] 30U 31Tol Page 0] Orientation Set @2 Hebd 2

=. Size: 371l AGG 21 AU Page b Size Pl Tdcl B3I Abdl &

= Column: S HILTE A 3T U Page # Column Create @3 Jdbed 2 303 0P Ul DI T2
Column # Distribute @53 Hbcl & 313 3H3 BIH DI HBA 8.evocvvreereve

= Breaks: 33 oo Hl s A3 AOE &

Page Hreaks
(1) Page Breaks........cooeenne. Page
P Mark the point sl which one page ends
(a) Page: $HP FiiI% AU UG Page DI ol AL A Break and the next page begint.
T2 Hbdl & | &6l I8, AS3A Bl Cursor (513 Fellal 13 Calimn
e = - = [neieata thiat the Pest falpadng the salumn
2ol a2l A < Page I Break P J01l 313 3H UD ofdil Page Z/=| brea<will segin inthe rext column.

# Insert @3 ¢oll | —h  TextWrapping

Separate text around abjerts onwen

(b} Column: ST SFoiAler ot Page @I Break ©Jol & —|  pages, such as @ption ted fram body test.
fete fopem Sitar 2 | #1513 3 Uacll Column 3 Break @35 | Section Sreaks

-~ - = =| MextPage
q;-lﬁ Column #H Insert PI Gl 2 :ni-.-ln; i :enh.u: break and start e new
. N : saction on the ned page.
3CIE20 A Heel Aol cilfael 3dol {63 Page & Gl
- " g I Confinuaus
Column S6iIc3 3341 & | 3113 30U U8d Column GTei Text -|  Ingert 2 section break ard start 16 naw
y ' section on the same gage,
Al Object I G Column H Insert BIG Tl & dl
e o = [ven Page
sa® [ow 30g 33 3iielel &I FadAlcd ©3 JAPd & = Insert a saction break and start the naw
e section on the next even-numbered pages.
£elle] 38 #H3H DI Cursor A FAGI WEGI @& AA | —
Bl’Eﬁ m F.n_!!rl'. a section break and start the new

section on the next odd-numb ered page,

{¢) Text Wrapping! SIDI FFcAICT Text B Wrapping @30l & fo1e oo Sir 2 4 30gel et it
Object @I Insert ﬁtﬂIé’Eg
SHD! ST & o1 3T B3 3l U5 Shapes Bl Inser: B2 33 33196 alc 3347 3o 12 et &3
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(ii) Section Breaks.................

(a) Next Page: #HL3H I Cursor {511 Femel w2 Elon a2t A 9 U ol Page Insert @3 ol 307 33t
MPageﬁmeFgfm

(b} Countinuous: & Section Page Break ZIdI 2 | 5l Same Page A Page Tl Break Il 2

(c) Even Page: e 3 Ao Afficia &3 3z ﬂﬁﬂﬁ—gﬁ@ﬂiﬁﬂﬁgmﬁ | eria
3BIct Even Page H oA Dt gﬁﬂlﬂﬂﬁ |

(d) Odd Page: U 293 [dame HiFsicia ©3 3017 3eIc] [Aus-Ute Ite U3 o=l 2935 WIs 3 | 3Held
30IcT Odd Page X TIH W1 Y30 I |

= Line Numbers: GFld3 Bl Ucald Uftb & el #Alfoid A disal A& Alsal & 0w 3@
SFcigtrel foan Sl 2

75, Hyphenation: ZEEolglel ﬁ]?;‘ﬁ Sil 9FeC ol 95al & maﬁfﬂﬂfﬁmﬁ P! dlgal &
3TciAfel Sl 2 JMelid 3°13 3l BIL T3 Word 121 3l uzdl aisal # Adjust o121 21 JoT al B
31 ¥ P Text DI HUI el cligel A LIS Soll i3 PH Text Dl [ofac dicl algel # DI Tl
3T 3113 g # Automatic B5 Hyphenation @1 Sign 191 ool |

3CIEI A 34

On the Insert tab, the galleries include items that are designed to coordinate with the overall look of vour
document. You can use these galleries to insert tables, headers, footers. lists, cover pages. and other docu-
ment building blocks. When vou create pictures, charts, or diagrams, thev also coordinate with your cur-

rent decument loolk.

= Watermark: 3913 307 31Ta1 Page 3 Watermark TI9I6l 91&d 2 T T e e

i = i =R | | E T
At 23 3iivorst W3 el B 317 BIE UB Format I I9I61 BT Jiie %, Seee 5 o sa
2 Custom Watermark U7 [Fcis 3% 33 Edit ©2 32 30sl

{3319 3 Name. Font. Color 3ceiilc diil @l dedl J...
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= Page Color: 331551 3icE 3 MU 3[Us] U &1 13 a5l Abd 2

7. Page Border: S 3T 3ol U3l # tRE-HE B [Gooin j T )
dig3 oion Jpa 2 | 30U A6 D 628 P e e
2ol ! [B1a SIEie! 331 : Box dicht Border, Shadow
dIcit d123. 3-D 8122, Custom Border HAT° 21 HT2l 31T

!
|

1

Art Gcit G153 #I ool ABe & |
= S

Gllc: 30T Hait 3ol & I ardt-ai3t A Check DI = Il
=

=. Paragraph Indent: ST 30T 3Ual Left 317 Richt Indent T 3161 Wi 2 AP 2

= Paragraph Spacing: $H31 31T 3ol Paragraph & Before ¥ After 31 Spacing W1 €l 7 G&l AP &

5. Position: =T 3ITOTE A9 Enable 21811 519 30T 253 8ff Object Y Insert AT Select B30I | THDL ASS
21 3101 31T Direct {5241 #ff Object BI Position @ T8I Text Wrapping Set B2 AP &

= Wrap Text: Text @I Wraping T30l b (¢ IBI 321dlc] (bl Sl 2 | 3 Highlight 79 2190 519
3T 12 Object B & Insert BIA 3 |

fr 3 Send 303 Bring Clail 3 dllel-dltel aifrgrer 2 BT wHlsI o3kt sft siicsine =1 |
BackﬁSendﬁﬂE\i_.Fruntﬁmmﬂﬁﬂmﬁmmmgi #HO1J <1
Ziat <fi5t v 3 3iferee sifesiae U2 cie] 8ldr & | 519 309 TP &l Fellol U2 UF A 3ifd®
Jifesiae 3aJic ObJ [Cel Jiidl & ol DX # SAL ﬁ@lﬁiﬂﬁﬁﬂﬂﬁmaﬂageﬁ’?ﬂlmgl

= I
1= aii

SEE

' Ermg Send Selectio
Forward = Bachkward + Pane

Selection .I_.
Fane

! Q.] Send Backward
]_ qa Send to Back
'l% Send Behind Taxt

S

Eh  Bring Forward
' &3, Bring to Front
% Brng m Fron} of Text
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Selection Pane: SH®D Sl U 3oAC el o bl o sifesiae &1 e =

3MAEL H Find, Hide Al Unhide B3I APd 2 TP 51d 93 HI Shape | ™ rreon [%
gy SIEIE ¥ 3503 363C I8 2 al U 3 U Particular shape Y | 0 -
Z41576 36l 306 G2l 2ldl #913 SHS A AT A 3 find B3 Priure 453 [
ADBAS |
Align: 3P 3loc dgd 2 3iiverE feu s1w 2 ST u=lel fooail off
Jilesiae @l Left, Center, Right, Top. Botton, Middle gcdlic A ¢l Tl &5
foe e sman 2
A
R Erminin
#llon Eatiom [ﬂl iz

Girtribute Homzomially
Dictrinute Yerticaly
Allgn to Fags
&lgnto Margin

Aime Satzsred CRl et
View Gridiines

Grid Setings..,

Group: 3P 3T {53 8t Object AT Shapes PI 3MTA 9 FISell TSd 2 U el 3HTglel BT T=ILI
37 AP & Tlp 33D FIe T A2 shapes ol Bremp 33 e shapeﬁ convert 853 Hbdl & 3113
S T8 o4 32 ungroup ¥l B3 A5 & | [ot #ff sifesiae B! group B30l & 018 T 30TD] el B
FIel H13 3ifeiae @I select T30l 3 3AD Al }TTD! sroup TICAE

Insert 3 Shapes After Selecting 3 Shapes After Grouping

Rotate: 33 5113 307 57 8ft Object B Rotate B3I TABAS
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(L’- sing References ?'-.‘ieml)

ATFcId A 33 Menu I 3ZcIdAc] 14 96 Il 2 319 24 Pls 3l Book I TSI Bl 2 eiid
59 &d DIs #il Book @I Create DIl diacl & B A TS 33 Menu I SIcislc] Dol U0l

1 Lgural, Arfeeaies Flaliigy Review ey Devetoper

IF'ﬂ |[Beana mxe 0 inzem EnBnmh =B () uansge st T—d'-' L Inse amidon Hgures = 1] inae e =R iy Iser ianie OF AsTnoane

1 a
at UpnELe Tebve AL et [ waminge ™ gy s APATOL ~ == Uposts ises Af Upozes moss o Lounefices
Izt ok s 3 laet 5 miverk : L Heik
roatnae =| ShUm iy Citstion -l EBllagmphy = | wHptian o) Cras-efeserite | eafatizn
E Citabans M frlicosant Captions |shie nf dathamtes

Table of Contents.......coooeenennsrsnnns.
(@) Table of Contents: $IP I T 3ol SiTgdic D “[AURIIEI" (Table of Content) THIZ B2
HADAE |

319 2 ARDIAIGE IS Dl HSFI 3 [53il 3l 722 & 9 31 d9rR 24 2 dl 2912 g1 T601TE 918
@’?ﬁﬁﬁﬁ' Chapter A TFAZ| I A2 Chapter @1 Manage Il I feIT “Table of Content”
D! Create [T AT Z |

Table of Content o5 rias o1 Blr 27

ﬁ'elcmnu | e e L A B g L L S R ety e R E P B R L3 K o TR SR Tl'-
T I e e s
Ribbon Menu i
T T e T e |
Using Minimize, Maximize & Close Button.......... Q
Nactionl Smoll Bar=sanmmrs s e Frr e s e s R e e e e e !
Honizontal Seroll Bar ... T e e 9
Zoom Shider. AR : S e L I T S 14
Rulers.. 140
HelpOption .o oo s i 3ot : 14
L (B L N T T Al Al e sl S oo e R e e (1

3051 3MMUc! U3 3 Sl ol 3341 &I “Table of Content” @&l Il & | &9 3H “Table of Content™ @1
HASS A A SF JDd 2 & Blol-A Chapter 853 Page & & 33 Direct 3H Page No. U3T Visit 3 3
IR O st s it
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Table of Content T2 Gelld a7
foreret: Eﬂi@ﬁﬁmcmptﬂglﬁggﬁﬁi‘@ﬁ FIJ Chapter &5 Name @l U Level &
fora # IIIB! Sample FSIEIV] B 13 FHSET A IBI ...

Noun

On the Insert tab, the galleries include items that are designed to coordinate with the overall look of vour
document. You can use these galleries to insert tables, headers, footers, lists, cover pages, and other doc-
ument building blocks. When you create pictures, charts, or diagrams, thev also coordinate with vour cur-

rent document look.

Pronoun

You can easily change the formatting of selected text in the document text bv choosing a look for the se-
lected text from the Quick Stvles zallery on the Home tab, You can also format text directly by using the
other controls on the Home tab. Most controls offer a choice of using the look from the current theme or
using a format that vou specify directly.

Verb

To change the overall look of vour document, choose new Theme clements on the Page Layout tab. To
change the looks availabie in the Quick Style gallery. use the Change Current Quick Style Set command.
Both the Themes gallery and the Quick Styles gallerv provide reset commands so that vou can always

restore the look of your decument to the original contained in vour current template.

Hol 36123V b dl2 U3 cilel Chapter Tolldl &
15t Chapter: Noun

- Add Text = ARl ,__|'E"]_Inse.'t 3

v | Do Mot Show in Table of Contents

2nd Chapter: Pronoun beial 3

3rd Chapter: Verb Lavel 2

319 361 J3il Chapter DI D Level © Level 3

s e ang ardt-ardt 31 F1eft Chapter 35 Heading 1 Select T3 37 “Add Text" A TSR 3A Level 1 &
Add 37 | ¥ I T3 Tl T TIC “References Tab” & 346G Table of Contents EIc1 3ivolel 7 31552 06
Format 1 Choose T2 33 frers =63 | Frors 55301 8t 3w w6t Rverset dame 28 sid....

(b) Add Text: S35 31662 Level Set 5201 o1 3ifvgrat e oFn £
(¢) Update Table: 3913 91 3 300! IS 313 Chapter 1 Add [&5en 2 adt 33 Table of Contents A cat & feme
Update Table ©5300 E191L.........

Microsoft Word 2010 Page 41




Foomotes..............

(a) Insert Footnote: 3Hcb 1321 30U 3Ual Current Document 3 Footnote Insert @53 Hebel 2 | ‘Footnote
Current Document 3 Current Page b a2 ford 31 Fela Sian 2 =t 531 Particular Word a3 A
FISIIG! ] BIH SIS |

(b) Insert Endnote: 3HD Giidel 30U 3Tl Current Document 3 Endnote Insert @62 bl & | Endnote’
Current Document 35 Ha3 fordel Page & 3o 2t 2 5 53 Particular Word T 913 3 9ISl &I
B DIl 3 |

{c) Next or previous Footmote & Endnote: 235 32 30T Insert f8521 10 Foomote 303 Endnote @61

(d) Show Notes: 2] U] Footnote 312 Footnote fﬁffc'}ﬁ]ﬂﬁﬂ

Citations & Bibliography......ccocvnerennn,

(a) Insert Citation & Bibliography: THD [
. DT e A ——

<21 3T a1 31T Book ﬂfﬁ'ﬁ@&_ﬂ o of stuare | TS~
FEAT| T

3131 Author Tldl a7 g I Title T 2 Pk
Year, City, Publisher Srenfe it @t Fill [f i

Sope; : o7 - S e

Tag ravn=
Flacehotder

Zal 71eft izl I Fill 70 P aIc Ok D3
& 3[UP! Il ¢ [ Ok D2d 2l U Aol TP Short Details Show 2l FIEFI | 31 30U Tt
Information @I Insert @536l Tladl & dl Bibliography dic 3ilel U3 562 fdei® &3

(b) Manage Source: SHPD G133 Insert [o52 310 Citation B Manage 3 Hbel 2 A2 Citation @BI
Delete @6l New Citation Add TIell Felic
(c) Style: S FALI<I A Insert 5% 91W Citation & Swyle GG ADrd 2

" Thiz 1= 2 footnote
=
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Captions. ..ooeeveiceee e

(a) Insert Caption: 33 AI09Te] &b S1i3¢l 30U B! Image @I Shape @1 Caption Name ¢ Hbd & Helid
a5t #ft Image AT Shape B Insert B3Il B FIG 3BT TP Particular Name & TBA B.enrve,

[ X 2

Figure 4 Figure 3 Figure 1 Figure 2

318i 3Uel 3343 3 5il SHI Figure 1, Figure 2, Figure 303 Figure 4. 3 f1328 & Name 1 gollall
Insert Caption Taclldl & | 1T 3P Name H cclld B3 HDd &.....o...

3 Default Name Sic1 &

5HT3 fofors 70 Name T g6l
BT ]

B (o7 -1

3CI&2UL-

T s e macb o e A o 455 S Bt o A AR A 4 A S S BB B R A A B B A A K AN S VB A 43
AN v 43 e A 0 R o S N A AR A AR A S 432
I B L B S S S i R i 43
Figure 4 43
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(c) Update Table: U3 # 3l 340l “Table of Figures” I ci<llJ [Fell o Al 3H Update 530l b 018
2l “Update Table™ @I S3aIc 52 Sirar 2 | cifdsar 3 dg ©mE ©90 34 30U P A1 361
Caption @I Insert TBIaL...............

(d) Cross-reference: 33 3iitorel & 51190 &# fball #ft Bookmark, Paragraph, Table. Caption, Heading
Zcanic; 51 B9 Short Link G611 Habdl 2 [313U3 Direct Click @3¢l 2 ## Direct Move I Hbdl 8

IndeX. e

(a) Mark Entry & Indexing: 320<b Slis<l 30U 631t #ff Selected Text @I Mark @63 Hebd 2 303 3HD
dlc 3! UF Index 1412 3 HPHdl 3 | ﬁM%ﬁT@@Tcﬂﬁ{)pﬁ @?ﬂg dMe3aa A
{5 Text B Select Bl g 3l 31 UF Index <2 DID —
Ry S

v gy [

foremer - uzct oot sft Text ot Select 3 I3HTT 30T Index T2 sty |

ol digd 2, 3D a6 Mark Enwy B3I | 33 728 A 3oL A e |
Text @] aPl-A13l A Select BIB Mark Entry D2 e amg ff| & oo

: | Page rapps
index I3 BIATEA 2 | S,
#age rumbes formel
i . g . [ ok
On the Insert tab, the galleries include items that are designed to co- e

. . - Thig b iy Hral e ik T
ordinate with the overall look of your document. You can use these [l mi v el e cemk mite

galleries to insert tables, headers. footers, lists, cover pages, and other Lok verkat ) cene |

document building blocks. When vou create pictures, charts, or dia-

grams, they also coordinate with vour current document look.

T
bmldmg, 42 ——
indmy | Tla ol antorme | Tale < Toprom | T nedadlatibn |
Frirt e
roordimate, 42 = Tewi W e
Artstotle, | S Cdanms L s
astaroid balt See Fupitar aLm:utum |:I||.\1 i
CERSTHINE, 42 A priere
zallenes, 42
R 9 Indexinz Column BN
e 2. 37 fE5erer Column &
Index TIOA TEAE
oeerail, 42
dindex StyleE BA
T I WS
Chooss BT HPAS
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(b) Update Table: dic # 9521 o10 ufiadia @ 33 F3E 8 Update 3 Aba 2 31l aie 4 [
12 pIs 8 Mark Entrv Indexing @1 Update 5301 o [c18 3 3iITyIe] &1 UEBl Had & |

Table of Avthoriios. ..o

() Mark Citation: SH® el 30U At Selected Text B Mark Citation ©2 HPd 2 3112 3°d
3iIC9lel &5 Il 3HD! Index I fidlI DI Al 8

(b) Insert Table of Authorities: S 3119el Mark Citation f521 51 Text B “Table"” Create B3I HPdl &

for & 3UPT BB Text PI Select BIP, Mark Citation PIol @b &l “Table of Authorities” AT
5ol 1§ ) - S —

On the Insert tab, the galleries include items that are designed to coordinate with the overall look of vour
document. You can use these galleries to insert tables, headers, footers, lists, cover pages, and other doc-
ument building blocks. When vou create pictures, charts, or diagrams. they also coordinate with yeur cur-

rent document look.

Cases

U 43
L .S 43
len el s R R R R A B A S e e R e A e S R S e 43
e 43

(c) Update Table: dic # [95<1 o0 ul¥daciol @I 331 FI3<I Update B3 ADdd &

——————
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(_Using Mailings Me mD

Home Tnast Page Layend AelereneEs MEiling

= A

Ervelppes Labels | Start Blail Sebert Edil Highlight | asdgess Greehing et Mergre Ful P T : Eirish &
Merge v [Recplents = Becipiers (1 |\ Marge Falde  Flac (T Eid » £ Updabe Lalsel Arnifts | 3 Lharge

oy Maten Fledds

ik Iriall IyleCige

Envelopes: S0P Gildsl 30U Envelopes fielI2 3 AP & 312 [CbAl o WA 3131 APl 3 | IHADI
SZCIAIel SAIGIAS E-Commerce Alct hFUlORIl @Il & delics 3ol ATol HiFeil Bl U PI8 A

melopes and Labels 1 I. o
_ﬂ_!.! r——
Envelopes: | Labds |
Dy ackresi:
DK Verma Dehli, India I & Delivery Address Eld1 & F&T
AID COMPUTER ZONE A 24 06 AELH =1 fsen
- EIrL 2 =il 2 Customer &1
I Add clegtionic pstag Address EleT 2
Eatn arddreas; ] omn
= | Preies Fead
-
DE Verma Patna India
AIQ COMPUTER ZONE 4 q [@] < Retum Address ZIA1 2 F81 &
—

- V=G B (e e O s 1 g
sinrify that an envelope 4«1 kfurg printing. 3relic] =1 39 Office AT Company
[ e [ Aot [ optone. | | Epostane ropetis... | 5] Address Bl A E

| Canenl

Liwe | ope Dl ang.

511 1m =]

Fammpl L

INEEAlsA palic i ssaea s ' o _;

Farzhaft (il &

Fanten [hufo 1

Option 91092 [Sores 5295 a1 3gal
Envelope Page 55 Size Bl Choose =2 01

A AT Setting 7 019t B =916 Foi# A Add to Document
q3 e $3 3951 Envelops T913 8l 3E6E0
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3IMA9YD ITIGTI !

3}O13 3T Start Mail Merse TIcl 3ivorel U3 foicies ac 2 Al 30U el 9l Jait 3iiveE o
SIRISI Sl f36 Mailing Tab # &1 =0 2 3=l Mailing Tab & A562 Jloidlc] ALJ 3iIT9ME “Start
Mail Merge™ #AfRRmmerm3............

Bl 3 A ls
Home Insert Fage Layout References
— @ ':'2 B 2 33 3oe: @t F8f siftoe Rusm A
| 55 = i s - : .
Envelopes Labels | (Start Mail]  Select Eat | HI Mailing Tab 5 9157 EAT 970 & | I 3R
o | | Erqiﬂ;&:qg_lin_h_ Recipient List | Mai itﬁ? a ﬂ a & SIEP—['J}'-E!EP ﬁ 31
Ll [ T r— T 3FA B ©5-UF AYE T choose
53 Eruelopes.. FIol IS01L, 33 alc &3 T I |
il Labets..
& Directony Gilc: SHAIT step-by-step T DIl
EE HMormal Word Document
ﬂ Step by Step Mall Merge Wizard...

Select documest bype

Whsl Iypeenl docurmenl sre ol
MI‘H.I‘FIH‘IT
& Lot sl dFm B
. 2 il step-by-siep-mail-
1 Labols merge-wizard 9
Fos =@ &
Serdiehien bagopotpuns, || TG 3 Leters; E-
{0 Can personatos e letier )
vt mach person recenEs. JI‘i.E.l! m&ssages:

Clck Keset o contres.
Envelopes, Lebels

geaie =1 3o
oz 3=l A
Mailling Tsb &
oy e i e
FHCI=El 20

Mailings Tab &5 31662 et st ziivoer 3l
aaep! f&2as © 781 8 9 Ha ATl step-by-
step work 2ol U2 6@ o | A Seleat
Recipients. Edit Recipient List, Preview Results,
Fimsh Merge, Insert Merge Field, Highlight
Merge Field se=ics

Microsoft Word 2010 Page 47




B Tfcie 3@ A Step-By-Step “Mail Merge™ 5] SHCIHICI D1 8

Mail Merge 1 SFdIcI 93-93 DFUHT DIl 3 Teiiies 3% SR 29 U 913 i agd 1Y 3l
3cTe] bl DI Letters, E-mail meggages, Envelopes Scalic I3 3 HPdA 2 313 Aolci-Acdol
31b fiie foreplct 31ad 2 | # 30UeH! el & [95 6 Step # Mail Merge Complete 21 3 &

Step (1) Select document tvpe Step (2) Seleet

FaA Usd U 3MSl Select docment bype. Staring Document Select starting document
e b '\: l.'thlIGt:.'mE uf documenl e yeu i e ) s b s U o
EIEF@IE &=l CISH gﬁ. workrg on? letler?
@ Letters M m Letters ﬂ @ ke the currenl docamenlt
i) E-mall meesaeg &3 set Up TIa0 ! Gmars Som a empate
T 171 envelopes e | Ekert +om eviskng decument
& g0 Al Taftel o1 : Ty
' Labels Usp the merreat o 14
Letters eIz @530l i Drectory — 5Laul:_:u tha uuurﬂaa:tsrmu
= (1) U=se the current hizre ond Lise S el Merge
gl g sdkme & Letters g wirar = e recpoes
_gr- Send felters oa groun ol people, document: SIEHHEﬁ mforrealinn
5 a‘_;f-‘i r Vou cen personaize the lethes =1 ;
Letters U2 check that mach nemon recEes. El_a?ljiﬁ' #

Chicke Ml 1o cordirns.

Dut@ﬁc:ﬂﬂ
{2) Start from a

template: 3r2A
Template Insert

TES

{3} Start from exiting
document el

OEc 3 T I
- : Step2off
Stepiofb SEEie A
= 9 Plext Select redpards
& st Staring dacnen| i &

3 Prawigus: Select oocarent: =
ot & “Tise the | kb el
current documant”
=] 3] Tl

S —————
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ep (1) Select rec i
Step (3) Select recipients fail Merge

Sroes P 30T Letter foe =52

; - Select recipients
32 2 35t =41 List gomett aeft Y Usie s Bt
mAffc i dlor s A o 1) Selecs from Outhok centacts
b
Type a new lisk
(1) Use an exiting hst; Type the names snd addresses of
recpients,
313 39S I UaC Joil g8 List & Create
&

£ @l T Insert 2 ADA S

(2) Select form Outlook contacts:
Ontlook, Microsoft Office oI 5
#1191 3 A8l 3 ot AT List B Insenrt
SIETAE

(3) Type 2 new list;

$HP HE AT fgId BF New

List {19112 53 BSl &
ailc: ZHCIST Type 2 new list (1913 Step3ot6
ﬁl' A7 w P List Creaie B Fexh Wiite your letler

& Previcue! Startng docsment
L= =1}

heew Addroes List

Type recpiznt infremabon it e tsbie. Toadd mocs enlriea, dick New Enifry,
Tle w[FmMame o |lad Mo w |Compeny Mame | Aodiess Lne 1w |

15

l ||:5:+|:1:Enl:r'r ] | Customize Colimns:.

34 SHCe 5H oo #H New Entry, Find, Delete Entry, Custom:ze Columns
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. HEGH UEcl ZHAcilol 3H Address List @I Customize Column T5Joll Hl2del Teiics 3HH 2d 90

35313 Field Name © 2795 & 3121 Name, Address, Mobile Number, State, Pin Code, Email 3c2Ifg &
A EA TS H A BIADAS

Neuldsre—ss Lst'

]'_vp:lﬁpmtnfn"'-rvn"wnn I:h:nbnh_. TcmE\: antes, dios e oy,
I?'Ilu - | B Mo -vll..:l'!n.m

T'I:'I-Tﬁ'-}m - [Anicar Lra 1w

‘—[ﬂﬁ:ﬁm@fifidxmeﬁadéﬂ:&ﬁg ]
.‘_

[@ﬂmﬁnﬁaﬁnemm = ]

REdicsiasa g
Coun Ragean ~
|mun:l1:--e o HE! 3 30d &3 #il Field neme 1
Wiork Fhonc
E-mal Address Rename 52 A &
—

3 At ug et o Field name 1
Move up = Move down T2 HEAE

‘l.lllllllIilllilllilllllilllillIIIIIIilllilllllllllillllllllllll
-

‘i
NN EEA NSNS EEEEE RN EECE e e e

Plew Address Lt
e = 1 Tvpe reocderi pfammezon in e isbl= To add rore eraves, ok Hew Siviry:
3| Baciie] dIch! o 3iivera] izl b e ST e e e ]
B fls
3313 114 &= a1 Ennry

B Find B3 AT S

U New Entry &2 Hbil 8

55T 1@ Entry &1 3q
Bdic sz msa g
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A SHCIT New Entry @2 31

| Nt Address L
Lype recpiantmfonraaon 1 e faole. T add mere e, chok New Eniry
|H.'l'rr. viﬂdn -llrth:m: viE'rr.I v-|_
1]
#Hol Customize 5301 @ 4G 1P
13 Field Name 31 BI1SI 2 | Name,
State, Phone 302 Email. 300 33
301 3OS B2 Fbl &
[ ewEniry. | | Srel.., |
|E-.irmtrrrrr | |l'lll:rn-rnE-frll-m..J 0K i | Caryrel

Mew Address Lisz

Tvpe recpient mformaticn n the ole. Ta'add more enfriss, dide New EnTy.

Haree - | 3= - | Phore + | Erail
Gopet Iharkhand 1245 Gopalfgmel.com
| Mtadan Hikat b MadanZyahaa.com
o Fmafgmel.com
For ool s Entry S clt
3E, # Ok Il 5ol 12 [aos
Pwel

T

Dot Entry | | utomare Enlupa, |

561 A3t <=l ool T5I0! o 91 3E 51l 30U 3eIct U # Sl SIREI 3A 30Uh]
Follow T5Jo & |
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Step (4):—--

IFE TSI el
Ud # T Letter
e SIem 2
Sl 3T Leter &

il Merge

Write your letter

Ifyou have ot already done g0,
W yolir letber riow,

To sdd reapent rriormaton T
yourr letier, cick @ locaton in the
doourent, and then cha one of
iz Hemes below,

5 Addess bl
& Creaing e .

.;-i Fertonic mostags. ..

T -
fCreaon dledd & Bl Moteiteme,,
3 temenm o= Wihen yeu have b wrting
= your |etter, cick Mext, Then yau
z | i Srediey and personalze sach
Eﬁ! recioient s [atter, Vet it FA 3
Tenk
| e Misids i sl Niskls
Erik
3E 3T More o
. aMame_» :5‘1::
Items & =0 3 = Er——
F aStaten
&5 =o1c1 3 ool
aPhones
Reazard
abmaily
| Step 4 of L e ==
| Hatch Meds... Irseit -3
% NEdh Previes yolr leces i L ;

# Previous: Szlectrecpisnts

Glic: Ul anl-aal A Hl Field Bl Insert
3l 2 | &7l 32 U Field I Insert BIol B
dIG 3MUP] Enter U P32 ¢oll 3, 3P 416 Uok:
U Field Insert @0l 8 3HD AIG Jol: Enter
Galell & | 32l g A IRl Filed B 30U®]
Insert BI Il 3 |

21 3T Letter o5 FEH 331 AEI H DI

3 U] Next ©Ieb UId Step o 506l &

Microsoft Word 2010 Page 32




Step (5):-—-

Step (3) Az dia
Complete Bl AT 2 | T
$3141 TSR] 390l Letter 61
Preview T2 FIKII & (IS
=I5 JIeTel &l fl 331 304
Edit 3 T

312 HE T Complete 2
T T AT Next B2

Step (6):—-
3 Mail merge I Hd 3feE T

ErI 2

3/ ATTHT Mail merge I 2l 9RT 2
IATF AFG Gl 3ivom GeamEn =1

&g
(1) Print; 309 912 Al 321 (2d e &2 Marga to New Docurment
HEA & | & AT T G [ 30T Merge rocorcs

Sivo cafem=gt =01 List dne [Se=m e @ Al

i Cument record

3ol 217 eaivpal o1 30 fuie forsre & From:

Foazddiceana

(1) Edit indivisual letters: S35 3=
30T Individual Z3sft ilsTl &1 3L
TPl Cic A B AP & | 51
3ifvotor foeTes Taal F aG BT
jTe=r=Coi
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Previes yoar et

Onz of the marged izter iz
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foleveang:

. REtpenid |

] Fnd 3 recment. .

You can aiso-chanos ypur
reqaoient st

0y Edtrecident int-..

.Eﬁdt'ﬂ'ﬁrmt

When you have fnghed
pradewang your ketters, dic
Maat. Then you cen pnnt the
merged lethes o edd mdviiud
lwtters to add personal comments,

Step fiof G

B Next Compleh e e o=

& Srpvioun Wirke vour leltey

Miail Merge
Complete the meme

#iall Mence B 1sady 1o produce
your ketters,

To persaiialile your el dick
Edit individuel Lekiers, ™ This wil
apen & reve dooument willy ot
mer ged etters, Tomeke changes
to o the letters, switcn badk to
the original doaument

Herge

;:Ef‘\rlll...

2§ Editindwidinl leters.
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(L’sing Review T'v]enu)

h o Jmmil :|-i|||l Lagmul Rafargniel Kalings Cossm Vipsm

A ﬂ ﬁ * :L'I. 24 Pt Shaw Markap

g U:! Bl @ % d _1 _i __1 £ B ik

Sxefiing & Bevewth Thewnnue Ward |- To lllllll.l Lbhuu.lul. Hew elal= dud s Timdh

£ lshindl Fiia] Earuitil - Elidriges = I8} REvawing Peree =
Franfing | Lemgape Csmn Friiy Tracking

= Spelling & Grammar: $HP 13 AT ATel Document A Spelling & Grammar @] Check @3 AP
B

= Research: 33 sitoel 304 {5241 #ff <51 O 913 A Research 3 Add &
= Thesaurus: A Select {35 91T Word & Similar Word Tl Suggest DIl 8

2 Word Count: 91 ¥cl U Document E: | Pages, Words, Line e
i3 B Count BIATE.....

Word Count

Stabshem
Pages
Wards
Charsited s (. sascer)
Characies b feath upoes)

Paragranpa
Lines

1] Ireciuie tewthowes, foomesen sl oncrotes

[ o= ]

= Translate: 32 a1 304 {531t Language &1 I Language A Translate B2 Abd &
. Language: 3314 31U Language Options @1 Choose 02 APl a

= New Comment: 330 Fit¥el 30T 530 sft Word, Line I Sentence @1 Select @30 3393 Comment
B3 AP 2 32 3 Selection B EII 9 P Gl AP 2

5. Delete:; $2105 139 304 Selected Comment @I Delete @3 Abel 8

= Previous: 3300 19 30T Previous Comment # 5Il Hbd &

= Next: SHD sitd=l 30T Next Comment 9 511 Dl &

= Tracking: SH3 Document 3 [Xb<I 918 Changes ™! Track T3 bl & 312 34 Manage T3 ADd 2
= Accept! Teidilel HHAE A, Document 3 [cbal 910 Changes iy Accept 3 HABd 2

= Reject: Tcidlol HAA a1, Document A [d5el 919 Changes @I Reject 2 bl &

2. Previous! ?J‘iftﬂjlﬁ @ 3f663 Previous # [doe] 810 Changes @I Accept II Reject 3 HADd &

=, Next: Siﬂﬂﬁf T Yoo Next A oI ame Changes B! Accept @l Reject B3 B3 (e TS I3
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= Compare: 3HP 3130 AT Multiple Document @1 Compare T Combine @53 Hdbd 2 | 514 a1 31T
Compare Tlct 3iitglel U3 [rcies 301 all TS A0l P 3 I DI ITole Fclb: ARG

Compare Dotumenls

mrF_lI:mmt hHrﬁ n‘

Compare Documents

Orginal document

| Labhel changes with

a"tal”a?ﬁta @I Choose J0l B dIG 3H Compare DI

S ——————
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(L’sing View Menu )

3 Menu & 36632 Tl A2 Options [T 318 F 513131 30T FcT Document & View # Uf3dciel ol TP
2 i THIT:-

o5 L i

Heme  Iraett  Pagelspout  Referances  Mallings  Biedew  Wiew

] (B [ (] (] 2 Q [Fdoeree = O | v | 5

Q Tows Prgey
Priefl  Full Sereer \Well  Duttne Oradt | Jaam  16Fs Hew  Aranige " : Swidch
Loyeut | feagng  Leyout fiwsgation Pane G Fage WIEIP. iedene Al Al Pexet Windes Patiian.  Windows=

Geldime A1 Serebuanais Seruiling

(i) Document View: b 311391 30U 3Tol Document Page TPl 3IcI01-3clo] Format A View @3 Hebdl
2 32 Print Layout, Full Screen Reading, Web Lavout, Qutline 32 Draft Mode &

(ii) Show: ZHHA 3 Options [S0 718 2 FH31 U=l UI T3B! 30U Tick Out B3I Enable I Un-Tick Out
TID Diszble BI ADAB..overee

(iil) Zoom: S3b o $il B3 HALI Options &0 o180 2 571 IFAHAI MU Page View D clilol @I

5. Zoom Option: 3HU3 &l T30 U 34 Boma

[ 2o =)
= = & - =
3 Page &I Zoom I AP & e =
20 ) 7 Page wilth 171 My pages:
[ T o (7 extvadth ==l
1) fu i ikl pege ."

Fercent: 3T |-

. 100%: 3AU2 [AfcTeP P3P 3T Direct Page DL 100% || meven ~
Zoom U3 €l HPBA 2 ===

‘ ARt dEe YT

AaboCeDdCekdyZ:

3. One Page: 3T [Sci® DIt & 3T T Page 3L ,
Wit ﬁ E 53'] = ;1 '—rg—; AabbCcDdEeiy vz
o] el

= Two Pages: SAUI [&cid ®3ad & ATDI Page T
$1Ie11 3 dc b3 oloil U Full Window 3 3T Fibicl U3 [S3el colLL..........

= Page Width: $3b S103¢ U] Page BIGI Zoom Bl SN 32l [Hidell Windows 31U Hidol
B sz @t gor o1 Rt oo ... ...

Microsoft Word 2010 Page 36




(iv) Windows: 33<b 36a2 #l @3 I Oprions [&T a1e 2 51 &b} @bl 31T Alel 5iIdl 2 A

= New Windows: 32142 fdrcied ®2a 2l 3UepI SI=ldic B New Document d G6el SIE90 302
Ugcl ATl Document 51301 I AT &1 I&01L.............

= Arrange All: 3@ 3T New Window U2 foiciod oI dgdd 313 New Document Joli<Il & oI 300
gl HiJ ARPIAHITC TS Bl BlEcd Bl HIAPI IH 3 dl 31T Arrange All U3 e B3 aEit-an
A 32 Arrange DD Side-By-Side Fshlel U2 g3 Al 2

= Spliv 3AD F13 [l v Siaegdic I ¢l el 8 dlsST 5 APl 2 | 30T 337 3iivglel W e
DID A3 Pl P TS T2 cI50D2 GalEe] 98l A 2l dl SITedic e GiEe...........

= View slide by slide: P17 30U dgd 3 SIaedic UI B0l B2 32 2 dl U3 3 31U 37 3ifvgle 13
[eretep b Hell STaddie ol slide by slide 2T 3117 338 M 8l ©3 JPd 2

= Switch Windows: 3P 34 ARSIANNT ds 3 ggrd i [E=—
Siapic e oA 5u 3391 At 5 ditom A s feet || BT | B
oft Sferpdie & Jump T3 F5A 2 A0 3T TH BIABAS AL [lwindows!| o
qa@[g‘iaﬂﬁg ﬁgﬂ 5l I Cut I Copy BIB @Eﬁﬂﬂﬁ 1 Decument? [Campatibllity Mede)

: 2 Documentd [Campatinility Meode]
# Paste @3 APl -
g b v | 3word 202 MHind)

e ——
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= Macros: 9 @BIBI Amazing I Useful 300 2 | 9 TS BELH

FIel STl JDal 2 Taifes 33t Aice A 3T 3AUel Keyboard I _
Record B3 APd & 32lid A dis o1 31y an-ae frad 2 39 jag0.
33d S04 3A Shortcut Follbl TP 13 # Open I Hbd [—

3 E Miew Macros

E Record Macra...

foremT: - 193 Uael 30U Record dlc 3iivgial U3 [9ce ® 3ab a6 1@ Pause Pecording

3[IT6T Recording Start 21 STRN

Curinrnize K yboa —
SRR UL -
Speifya enemered

Catmpeia
Haaos

Frozs [ow smrtuthe

fao thargea | Pmal
Cesriphon

314 30U Record Macros U2 [diciap @391 oll HEA Uacl Tb Dialog Box Qﬂ@lﬂ_ﬂﬁﬂﬁ dici
Screenshot 31 fG23ame o 2 | MMUSBT Kevboard dlcl 3iitolel U3 farcie o3en 2 | 33 &1 30
Record dlci 3ilteld U2 icres ®el 42 2l B 317 Dialog Box E‘;ﬁ?ﬂ 3t @Bt @ Screenshot &
f&=aren orm 2 | 3a 533 Shortewt Key @I 3 ©361 3H Shoriout Key @I Gdld al dl Text

Automatic Type 2l FEEI

allc: = Photo, Audio. Video 3callic Thsil @1 Record Gl @osan o RB1E Kevboard @1 Record @l

2 51l 30U Tvpe DIGL...
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Ej SHORTCUT KEYS ﬂ

(' FILEMENU )
S.N. Shortcut Action
1 Cul+S Save
2 Fi12 Save As
3 Crl+0 Open
- Crrl =W Close Document
E Ctrl+N New Page
6 Cul+P Print
T Fl Help
8 Alt + F, Then Press “I" Info
9 Alt —F. Then Press “R* Recent
10 Alt—TF, Then Press “D* Save & Send
11 Alt + F, Then Press “T™ Options
12 Alr—Ad Ext
( HOME MENU )
S.N. Shortcut Action
1 Cul-X Cut
2 Cul-C Copy
3 Cul+V Paste
4 Ctl +Shifi +C Format Painter
3 Cul-B Bold
6 Cul+1 Italic
T Crrl U Underlne
_?_ Cul - Shift +D Double Underline
0 Ciri+ D, Then At +K Stnkethrough
10 Ctrl == Subscnipt
11 Crrl + Shuft - + Superscript
12 Ctrl ~Sheft+ F Font
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SN. Shortcut Action
13 Col - Shift =P Font Size
14 Col - Shift — > Shnnk Font
13 Cirl + Shaft - < Grow Font
16 Shift - F3 Change Case
17 Ctrl - Shift + N Clear Formatting
18 Cti+ Alt+H Text Highlight Color
18 Alt+H+H Font Color
20 Alt+H-+FT Text Effects
21 Cul +Shift =L Align TextLeft
22 Cul+E Center
21 Cul-R Align Text Right
24 Cul=1 Justify
25 Alt+H+U Bullets
26 Alt+H+N Numbering
27 Al-H+M Mulnlevel List
28 Cul+M Increase Indent
24 Cul + Shift = M Decrease Indent
3 Cul+1 Single Spacing
£ Cul<5 1.5 Spacing
32 Cl+2 Double Spacing
33 Crl+0 Zero Spacing
34 At+H+O Shoe & Hide Paragraph Marks
33 Cul+H-H Shading
36 Alt-H+B Border Options
37 Crl = Shift + N Apply the normal style
£ Alt-Cul -1 Apply the heading 1 style
ic Alt+Cul =2 Apply the heading 2 stvle
40 Alt+Cul =3 Apply the heading 3 style
41 Crrl + Shift + L Apply the list stvle
42 Alt-H+G Change Style
43 Curl +F Find
44 Cul-H Replace
43 Cul-G Goto
46 Cul-A Select All

e ——
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( INSERT MENU )

S.N. Shortcut Action
1 Alt+N+V Insert Cover Page
2 Ctrl — Enter Blanks Page
3 Alt=N-=B Page Break
4 Alt=N-=T Table
3 A+N+P Insert Picture
6 Alt+N<+F Clip Art
y, Alt+N+5H Shapes
g Alt-N+-M SmartAn
g Alt=N+C Chart
1d Alt+N-+SC Screenshot
11 Cul - K Hyperimk
12 A+N+EK Bookmark
13 Alt+N=+RF Cross-reference
14 Alt+N+H Header
15 A+N+0O Footer
16 Alt=N+NU Page Number
17 Alt+N+X Text Box
18 AE+N+Q Quick Part
1a Alt+N-W WordArt
20 At=-N+RC Drop Cap
21 Alt+N+G Signature Line
22 Alt+N+D Date & Time
23 Alt+N-=1T Object
24 Al-N+E Equation
75 Alt+= Equation Mode
26 Alt+N+U Symbol
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( PAGELAHOUT MENU )

S.N. Shortcut Action
1 Alt=P-TH Themes
2 Alk+PLTC Theme Colors
3 Alt+P-TF Theme Fonts
4 Ak=-P-TE Theme Effects
3 Alt+P+M Page Margins
£ Alt+P+0O Orientation
y, Akt +P=58Z Page Size
g Alt+P+1 Columns
g Alt=P+B Insert Page and Section Breaks
110 Alt=N=1IN Line Numbers
11 A+P+H Hyphenation
12 Alt+P+PW Page Watermark
13 Al=P-PC Page Color
14 Alt+P-PE Page Borders
15 Alt+P+PO Object Position
16 Ak+P+TW Wrap Text
17 Alt+P+ AP Selection Pane
18 Alt+P+AY Rotate
19 Alt+P+AA Align
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( PAGE REFERENCES MENU )

SN Shortcut Action

1 Alt=5-T Table of Contents

2 Alt+5+4 Add Text

3 Alt+5+0T Update Table

- Alk+5+F Insert Footnotes

3 Alt+-85-1 Insert Endnote

6 Alt+S+N Next Footnote

7 Alt+5+P Previous Foomote

g Alt+5+X Next Endnote

g Alk+5+V Previous Endnote

14 At-5-C Insert Citation

11 Alt+8+G Insert Table of Figure

12 Alt+5+T Update Table (Captions)

13 Alt+S5+RF Cross-reference

14 Alt+8+N Mark Emry

15 Alt+5+X Insert Index

16 Alt+S+DU Update Table (Index)

17 Ali=-5-1 Mark Citation

18 Al+S4LRT Insert Table of Authorities

19 Alk+S+RU Update Table (Tablz of Authonties)
20 Alt+5+M Manage Sources (Citations & Bibliography)
21 Alt=8S+L Style (Crtations & Bibliography)
22 Alt+5-B Bibliography
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(' MAILINGSMENU )

SN. Shortcut Action
1 Alt-M+E Envelopes
2 AR—-M-+L Lebels
3 Alt+M-5§ Start Mail Merge
- Ak+M+R Select Recipients
3 Alt+-M+D Edit Recipient List
6 Alt—-M+H Highlight Merga Fiends
7 Alt-M+A Address Book
g Alt-M+G Greeting Line
g Alt=M-+I Insert Merge Field
1d Alt-M+U Rules
11 Ak-M-+T Match Frelds
12 Alk+M-B Update Lebels
13 Alt+M-+P Preview Results
14 Alt+=M+Q First Record
15 Alt-M+M Previous Record
16 Al-M+X Next Record
17 Alt+M+V Last Record
18 Alh+M-1T Find Recipient
19 A+-M+K Auto Check for Errors
20 Alt+M=F Finish & Merge
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(' REVIEWMENU )

SN Shortcut Action
1 Fi Spelling & Grammar
2 Alt + Chck Research
3 Shift — F7 Thesaums
- Alt-R+W Word Count
3 Alt+R+L Translate
6 Ak+R+TU Language
7 Alt+R+C New Comment
g Alt+R-D Delete
g Ak+BR+V Previous Comment
14 Ali-R-N Next
11 Corl -+ Shift = E Track Changes
12 Alt+R-TD Dusplay for Review
13 AR+R=1IM Show Markup
14 Alt+R-+TP Reviewing Pane
13 Alt-R-A Accept
16 Alr+R+]J Reject
17 Alt+R +F Previous
18 Alt-R-H Next
10 Ak+R+M Compare
20 Alt-RE+PFE Block Authors
20 Alt+R-+PE Restrict Editing
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VIEWMENU )

SN. Shortcut Action
1 Alil-W-P Print Layout
2 Alt—- W-F Full Screen Reading
3 A WL Web Lavout
4 Alt+W+TU Outline
J Alt+W-E Draft
6 Ah+-W+R Ruler
7 Alt+W=G Gridlines
g Alt+W=K Navigation Pane
¢ A+-W+Q Zoota
10 Alt=W=7 100%
11 Alt+W+1 One Page
12 Alt+W-+2 Two Page
13 Alt+W-1 Page Width
14 A +-W-N New Window
15 Altl=W-—4A Amange All
16 Alt=W+S§ Split
17 Alk+-W+B View Side by Side
18 Alt-W-V§ Synchronous Scrolling
19 Alt+W-T Reset Window Position
20 A+ W+W Switch Windows
21 Alt+W =M Macros
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Important MS Word Shertcut Keys
SN. Shortcut Action
1 Cul+F1 Hide or Show the nbbon
2 — Jump one character to the nght
3 — Jump one character to the left
4 1 Jump one line down
% T Jump one line up
6 Crl+— Jump one word to the nght
i Ctrl + « Jump one word to the left
8 Crl+ 4 Jump one line down
a Cml -1 Jump one line up
10 End Jump to the end of a line
11 Home Jump to a beoipming of a line
12 Page Down Jump one screen down
13 Page Up Jump one screen up
4 Ctrl + Page Down Move to beginning of the next page
15 Ctrl + Page Up Move to beminning of the previous page
16 Alt + Ctrd + Page Diown Jump to top of visible windows
17 Al +Cul +Page Up Jump to button of visible window
18 Ctrl +End Jump to end of document
12 Shifi—— Extend selection one character to the right
20 Shifi — — Extend selection one character to the left
21 Cul — Shifi+ — Extend selection one word to the right
22 Cirl — Shift — — Extend selection one word 1o the left
23 Shift - End Extend selection to the end of a line
24 Shift - Home Extend selection to the baginmng of a line
25 Shift + Page Down Extend selection one screen down
28 Shift + Page Up Extend selection one screen up
27 Ctrd + Shuft — End Extend selection to end of document
28 Curl + Shift + Home Extend selection to beginning of document
20 Alt +Crl + Shjﬁg_[)own Extend selection to end of visible window
30 Alt + Crrl - Shift + Pe Up Extend selection to beginning of visible window
31 Delete Delete one character to the nght
32 Backspace Delete one character to the left
33 Cirl - Delete Delete one word to the night
34 Ctrl + Backspace Delete one word to the left
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